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classmates and instructor on the message board.  
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If you just wanted to type some text, you probably would've used a word processor like Microsoft Word, 
right? Publisher excels at combining text and graphics in interesting ways, and now that you understand 
how to use text in a publication, it's time to explore some of those possibilities. 

Draw with the drawing tools

Where do graphics come from? In some cases, you create them yourself. For sophisticated drawings, you'll 
probably want to use a third-party graphics application, such as Adobe Illustrator or Photoshop. However, if 
you just want a few simple lines or shapes, you can use the drawing tools in Publisher. They're quick and 
easy and are similar to the drawing tools offered in other Microsoft Office applications. 

Figure 4-1 labels the drawing tools on the Object toolbar. To draw with one of them, click the button, and 
then drag on the page. 

 
Figure 4-1: Drawing tools.  

When drawing a line or arrow (which is a line with an arrow on the end), to make the line perfectly vertical 
horizontal or an angle of a multiple of 15 degrees, hold down the Shift key as you draw. Holding down 
Shift when you draw an oval, creates a perfect circle; with a rectangle, it produces a perfect square. 

TIP  
To draw a perfect 1- x 1-inch square, select the rectangle, and then double-click the page rather than 
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dragging. Doing the same with the oval tool selected results in a circle with a 1-inch diameter. 

The AutoShape tool requires a bit more explanation. Clicking it opens a menu of categories of predrawn 
shapes. Click a category, click the desired shape, and then drag across the page to draw it. Figure 4-2 
shows the AutoShape menu system. 

 
Figure 4-2: Available AutoShapes.  

Format lines and fills 

Drawn lines and shapes can be colored and filled the same as text boxes. Select the shape, and then use 
the Line Color drop-down list or Fill Color drop-down list on the toolbar, as you learned in earlier lessons for 
other objects. You can also use the Line/Border Style button's menu for line thickness, the Dash Style 
button's menu for dashed lines, and the Arrow Style button for different arrowheads. Figure 4-3 shows 
these different buttons.  

 
Figure 4-3: Set line and fill properties for the drawn objects using these toolbar buttons.  

Rotate and reshape drawn objects

Notice the little green circle above a drawn line or shape, shown in Figure 4-4? That's its rotation handle. 
Drag it to rotate the object. (Try it!)  



Notice the little yellow diamond(s) on a drawn AutoShape? They don't all have them, so if you don't see 
one, then try drawing one of the more complex AutoShapes. You can drag that diamond to change the 
shape of the object. Different objects have different dimensions you can change. (Again, the best way to 
learn is just to try it!) 

 
Figure 4-4: The green circle rotates; the yellow diamond reshapes.  
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Clip art is predrawn, resizable artwork. It gets its name from the olden days when it came in a big printed 
book and users would clip various pieces with scissors. Nowadays, however, clip art is primarily computer-
based. Clip art images are usually stored in a format called WMF (Windows Meta File) or a variant of that 
called EMF (Enhanced Meta File).  

Owning Publisher entitles you to access to the online Microsoft Office clip art. Most of the clip art in 
Publisher is drawn from that Web site, so if you're not online when using Publisher, you don't have many 
clip art images to choose from.  

To open the Clip Art task pane, do one of the following: 

• Select Insert > Picture > Clip Art.  
• Click the Picture Frame button on the Objects toolbar, as shown in Figure 4-5, and then select 

Clip Art.  



 
Figure 4-5: The Picture Frame button opens a menu with several types of graphics.  

The first time you access clip art, you're prompted to catalog the clips. Click Now to do so; it takes several 
minutes. You can also choose to do it later, and you'll be reminded to do it each time until you do. 
Cataloging clips makes searches more effective, so you should do it as soon as possible. 

The Clip Art task pane, shown in Figure 4-6, appears from which you can search for a clip matching your 
needs. 

 
Figure 4-6: Clip Art task pane.  

View a larger version of this image. 

Each clip has one or more keywords associated with it. Type the keyword you're looking for in the Search 
for text box, and then click Go. An assortment of clips that have the word you typed as a keyword appear. 
Click the clip you want, and it appears in your publication, in its own frame. You can move and resize that 
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frame as needed. 

Work with the Clip Organizer

If you want to browse all available clip art, rather than search by keyword, you can use the Clip Organizer. 
In the Clip Art task pane, click the Organize clips hyperlink. This opens the Microsoft Clip Organizer 
window. Then click a folder on the Collection List to see the pictures within it.  

The folders in the Collection List are cataloged based on what the Clip Organizer found when it searched 
for and organized your clips initially. A separate folder appears for each folder in which it found pictures of 
any type, not just clip art. The clip art that comes with Publisher is in a folder called Office Collections. 
Within that folder are subfolders by category. Click a category to browse the clips within it. The Web 
Collections folder contains subfolders that link to Microsoft Office Online: Microsoft's online repository of 
clip art. You can browse the clip art available from the Microsoft Web site directly through these folders. 

The Clip art on Office Online hyperlink in the task pane opens a Web page from which you can browse 
available clips at Office Online, as an alternative to using the Web Collections folder. The same clips 
appear either way. 

To work with a particular clip in the Clip Organizer, point to it, so an arrow appears to its right, and then 
click the arrow to open a menu, as shown in Figure 4-7. 

 
Figure 4-7: Clip menu.  

TIP  
Clips with a small yellow star in the bottom-right corner are animated. In a publication for print, this doesn't 
do anything, but on a Web page or on-screen presentation, such as in Microsoft PowerPoint, the clip 
would have a simple animation sequence. 

You might want to copy a clip from the Internet to your hard disk so you can use it later when the Internet is 
not available. To do so, select Make Available Offline, and then when prompted, select a local folder in 
which to store it. 

You cannot insert a clip into a publication directly from the Clip Organizer, but you can copy it (Copy 
command on its menu), and then close the Clip Organizer and select Paste (Edit > Paste). You can also 
drag-and-drop from the Clip Organizer into a document. 
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Many publishing projects involve using your own artwork, such as 
digital photographs or computer-generated drawings. At the beginning 
of this lesson, you saw how to create your own simple drawings, but if 
you create them in some other program (or capture them with a 
scanner or digital camera), you need to insert them into Publisher. 

Publisher accepts a wide variety of graphic formats, so you should not 
have to worry about the format being compatible. Some of the formats 
Publisher accepts include: 

• BMP (Bitmap)  
• CGM (Computer Graphics Metafile)  
• CorelDraw  
• GIF (Graphic Interchange Format)  
• JPEG (Joint Photographic Experts Group)  
• Kodak Photo CD  
• Macintosh PICT  
• PCX (Picture Image)  
• PNG (Portable Network Graphics)  
• PostScript  
• TIFF (Tagged Image File Format)  

 
WARNING  
If you use a picture you've acquired from a Web page, make sure it's 
not copyrighted and that you have permission to use it. Otherwise, 
you might be subject to legal penalties. 
 

One way to get a picture into Publisher is to copy-and-paste it from 
another application. Publisher fully supports this kind of data exchange. 
However, there are also some methods that don't require you to open 
the picture in some other program first. 

Follow these steps to insert a picture that's stored as a file on your 
system: 

1. Click the Picture Frame button on the Objects toolbar, and 
then select Picture from File. The mouse pointer becomes a 
crosshair.  

2. Drag on the page to draw a box where you want the picture 
frame or single-click the page to use a default size.  

3. The Insert Picture dialog box, shown in Figure 4-8, appears; 
use it to select the picture you want.  

You can also open the Insert Picture dialog box by selecting Insert > 
Picture > From File. When you do this instead of creating the frame 
first, Publisher places the picture at a default size in the center of the 
page, and you must move and resize it after insertion. 

Scan your images 

Use your own images, logos, 
and photos to personalize your 
publication. 

 

» HP Scanjet 5550c scanner 
series

 

» Scanner buying guide 
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Figure 4-8: Insert Picture dialog box.  

If you do not see previews of the pictures, as in Figure 4-8, open, select 
Thumbnails from the Views button.  
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If you were paying attention in the earlier lessons (and of course you were, right?), you already have many 
of the skills you need to format graphic objects.  

Let's review: 

• Resize: Drag the selection handles.  

• Move: Drag the border or the center of the graphic. (With a graphic it's all the same.)  

• Change the border: Use the Border Style, Dash Style, and Border Color buttons on the 
Formatting toolbar.  

• Change the fill: Use the Fill Color button on the Formatting toolbar. Applicable for clip art only, 
not for photos. Depending on the clip, it may fill the background behind the picture or it may 
change the color of the picture itself.  

More about graphic size and placement

So far you've used an eyeball method of moving and resizing, but you can get much more precise than that 
by using the Format Picture box. 

Try this to see how it works: 

1. Insert a piece of clip art.  
2. Right-click it, and then select Format Picture. The Format Picture dialog box appears.  
3. Click the Size tab.  
4. Enter a precise size for the picture in Height and Width boxes in the Size and rotate section. Or, 

to resize the picture as a percentage of the original, enter values in the Scale section, as shown in 
Figure 4-9. Click OK.  



 
Figure 4-9: Size tab of the Format Picture dialog box.  

TIP  
To retain the aspect ratio for the picture, make sure the Lock aspect ratio checkbox is checked, and then 
enter only the desired height or only the desired width. The other dimension will adjust automatically. 

There are similarly precise controls for graphic placement. Continue with the following steps to see them: 

1. Right-click your clip art, and then select Format Picture again.  
2. Click the Layout tab.  
3. In the Position on page section, enter precise values for the image's starting position. Enter a 

numeric value in the Horizontal and Vertical boxes, and then select to what that value relates in 
the From box, as shown in Figure 4-10. Click OK.  



 
Figure 4-10: Layout tab of the Format Picture dialog box.  

TIP  
There are also alignment and distribution commands in Publisher that you can use to position objects in 
relation to other objects on the page. These are covered in the Advanced Publisher course. 
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The Colors and Lines tab in the Format Picture dialog box gives you 
more options for lines and fills than are possible with the toolbar button 
methods. You can explore these on your own, but first here's a trick 
with border lines to illustrate one of these options in particular. 

The following steps create a border around a piece of clip art that is 
unequal in thickness on the various sides. This creates a faux shadow 
look. 

1. Insert a piece of clip art.  
2. Right-click it, and then select Format Picture.  
3. Click the Colors and Lines tab.  
4. In the Presets area, click the left button, the one that looks 

like a blank (no lines). This clears the Preview grid above it.  
5. In the Preview area, click the button that represents the 

bottom border.  
6. Hold down the Shift key and click the button that represents 

the right border. You should see gray markers in the Preview 
sample indicating that only those two sides are selected.  

7. In the Line section, open the Color drop-down list and select 
gray. It can either be a placeholder or a fixed color; it doesn't 

Great deals 

Setting up a print shop in your 
office can be costly. Save 
where you can with special 
offers from HP. 

 

» Save $100 instantly on 
select Color LaserJet printers 
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matter for this practice.  
8. In the Weight text box, type 10 pt. The preview should 

resemble Figure 4-11.  

Figure 4-11: Set up a border on some -- but not all -- sides of an 
object a special effect.  

8. Click OK. Now it looks like there's a gray shadow behind the 
clip art.  

Create a shadow with the Shadow button

The last steps showed you Publisher's ability to place borders on 
individual sides of an object, but if you really want a shadow, it's much 
easier to use the Shadow Style button on the Formatting toolbar. 

Try this: 

1. Insert a piece of clip art. This experiment works best if you 
select one that has a lot of white space behind the drawing, 
not a square-ish one.  

2. Select the clip art and click the Shadow Style button on the 
Formatting toolbar. On the menu that appears, click one of the 
styles, as shown in Figure 4-12.  



 
Figure 4-12: Select a shadow style.  

3. Notice that the shadow applied to the clip art image itself, not 
to the frame around the image. Now that's different, huh? It's 
not the same effect at all as that faux shadow you created 
earlier.  

4. Apply a fill color to the clip art. (Select it and select a color 
from the Fill Color button.) Notice what happened to the 
shadow. It now shadows the rectangular frame around the clip 
art, not the image itself.  

Remember that on clip art with no background fill, the shadow clings to 
the clip art itself. If there's a background fill, the shadow clings to the 
outer frame. This is important because the same rules also apply to 
other objects as well, such as drawn shapes and charts. 
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Now that you know how the Shadow button works, why not move right next door and look at the 3-D button 
as well? It applies 3-D effects to objects, to make them look like they're jumping off the page. 

3-D effects do not work with clip art or imported graphics. They do work with drawn shapes, however, so 
let's revisit those. 

Follow these steps to make a square into a cube, for example: 

1. Using the Rectangle tool, draw a square. (Hold down Shift as you drag to create a perfect 
square.)  

2. Fill the square with the color of your choice.  
3. Click the 3-D button on the Formatting toolbar. A menu appears, as shown in Figure 4-13.  



 
Figure 4-13: Select a 3-D effect.  

4. Click one of the 3-D effects. The square now looks more like a box.  

TIP  
For more control over 3-D effects, select 3-D Settings from the 3-D button's menu. This opens a 3-D 
toolbar, from which you can change the slant and depth of the effect. 

Moving on

In this lesson, you learned how to insert and manipulate drawings, clip art, and digital photos. There's a lot 
more you can do with images in Publisher, and many of these more advanced techniques are covered in 
the Advanced Publisher course. You may want to experiment with them on your own for now. The best way 
to learn is to experiment. 

Before move on to Lesson 5, make sure you do the assignment and take the quiz for this lesson. Then 
check in on the Message Board to see what your fellow students and instructor are up to. 
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